GUIDELINES FOR PREPARING
THESES, DISSERTATIONS, & DOCTORAL ESSAYS

2007-2008 Academic Year

University of Miami
Graduate School
1541 Brescia Avenue
Coral Gables, FL 33124-3220
Wanda McSwiney
Dissertation Coordinator
Phone: 305-284-4154
Fax: 305-284-5441
Email: grad.dissertation@miami.edu
# TABLE OF CONTENTS

Outline and Purpose........................................................................................................ 1  
Advance Copies and Drafts............................................................................................. 1  

## FORMATTING 2

- Stylistic consistency and precision of presentation........................................... 2  
- Margins, spacing, and font size........................................................................ 2  
- Block quotes........................................................................................................ 3  

- Page numbering and order of the Front Matter.............................................. 3  
- Body of document pagination........................................................................ 4  

- Table of Contents and division of the manuscript........................................... 4  

- Tables, Figures, Graphics............................................................................... 5  
- Abstract, title page, and Vita.......................................................................... 5  
- References and Notes..................................................................................... 6  
- Printing and Paper.......................................................................................... 6  

- Submission of hard copies and electronic documents (ETD)....................... 7  

## PAPERWORK 8

- PhD/DMA or Master’s Degree checklists......................................................... 8  
- Certificates of Defense.................................................................................... 8  
- Signature Page(s)........................................................................................... 8  
- Surveys........................................................................................................... 8  
- (PQIL) ProQuest Information and Learning Forms...................................... 9  
- Mailing Label.................................................................................................. 9  

- Diplomas......................................................................................................... 9  

- Style Manuals................................................................................................. 10  
- Microsoft Word Pagination.............................................................................. 11  

## PREPARING YOUR ELECTRONIC DOCUMENT 12

- Converting Microsoft Word to PDF............................................................... 12  
- Note to LaTeX Users....................................................................................... 14  
- Multimedia Files............................................................................................... 14
OUTLINE AND PURPOSE: THESIS, DISSERTATION, & DOCTORAL ESSAY FORMAT REQUIREMENTS

The Guidelines

The Guidelines provide the general format requirements of the Graduate School, along with detailed editorial advice that may be useful in your preparation of the final draft of the graduate document. In addition to these guidelines, you should conform to the requirements of your advisor and committee in the preparation of your final draft. However, the guidelines are intended to be the final word on the uniform style that University of Miami graduate documents must possess. Because of this, the guidelines are reissued every year, and it is the student’s responsibility to obtain the most recent edition to be sure that his or her document follows the current and acceptable format. Please do not consult or rely on older bound copies that may be available in your department, nor should you consult ETD’s online for formatting. The current guidelines are your source for acceptable formatting procedures.

Contact the Dissertation Coordinator regarding any special problems not covered by the style manual your discipline follows, or by these instructions.

Advance Copies and Drafts

It is also required for all students to provide an advance copy (draft) for the Dissertation Editor(s) to review to prevent problems in the final version that will be submitted.

At the start of the semester in which you plan to defend:

- Check the Graduate School’s Thesis and Dissertation Website and familiarize yourself with the process. Download all instructions, guidelines, templates, and the required paperwork for your degree.

- Submit a pre-defense draft of your document for review by the Dissertation Editor at least 10 school days prior to your defense date. You can do this via email (grad.dissertation@miami.edu) or by dropping off a hard copy of the document at the Graduate School. If you send your draft via email, please consolidate it into no more than 4 files.

- Schedule your defense. Please be aware of the deadlines for the final submission of your document so that you have enough time after your defense in case you need to make any changes to your work. The deadlines for the 2007-2008 academic year are as follows:
  - Fall 2007: Monday November 26, 2007
  - Summer I 2008: Monday June 9, 2008
  - Spring 2008: Friday April 18, 2008
  - Summer II 2008: Monday July 21, 2008

- After your defense, make any changes recommended by your committee and/or the Dissertation Editor. Submit a revised, post-defense draft no more than 1 week after your defense.

- No further edits recommended by the Dissertation Editor? You will be instructed to upload a PDF version of your document to the ETD (Electronic Theses and Dissertation) database within 48 hours. Do not upload your document until you have been instructed to
do so. At this point your hard copy or copies and all supporting paperwork are due in the Graduate School.

**FORMATTING**

**Stylistic Consistency, Margins & Spacing, Font Size**

**Stylistic consistency and precision of presentation:**

Precision and consistency are essential features of the presentation of a scholarly work; if the confidence of the reader is lost due to inaccuracies in the author’s presentation, the entirety of the author’s work is devalued.

The graduate document is required to conform to the practices of standard written English without exception, and both the student and the graduate committee must make every effort to prevent inaccuracy and error in the copy to be submitted. If you have doubts about English grammar or spelling, consult your department for assistance. Graduate documents that do not conform to the practices of standard written English, especially in terms of grammar and spelling, will be returned to the author for revision. The Writing Center at the University of Miami is a useful resource; they are located at 5225 Ponce de Leon Blvd, next to the Canterbury Preschool, (305) 284-2956.

**Margins, spacing and font size for the text:**

Set your margins as follows: 1.5 inches on the left side, 1 inch at the top, bottom, and right side. As the bookbinder will trim edges of your paper in the binding process, there is no flexibility in the size of the margins for any page of your paper. You may fully justify or use ragged right, whichever looks more pleasing to the eye and causes the least difficulty with respect to the formatting requirements laid out here.

Because the microfilming process reproduces the manuscript in minimized form, the microfilmer advises authors to use 12-point font exclusively, for all textual materials, including appendices (see exception for tables and figures below). Acceptable fonts include Arial, Times New Roman, and Courier New.

Your text must be double spaced. Single-spacing of the text is not allowed, except for footnotes, indented quotations, figure legends and reference list. These features must be single-spaced.

Spacing between sections, above and below block quotations, etc. should be maintained consistently throughout the text. There must be no large unnecessary gaps. Normally, paragraphs within a given section of the text follow consecutively one after another with no breaks or extra spaces. They should be indented to indicate their beginning unless the paragraphs are meant to be different subsections. The use of spacing between ordinary paragraphs, while acceptable for a document written in pamphlet format, e.g. these guidelines, is not acceptable for theses, dissertations, or doctoral essays.

Pages that are entirely empty are to be avoided.
### Block Quotes

Remember that when you have long quotations (typically of three lines of more) the text is **indented on both sides and single-spaced**. Do not use quotation marks on indented (block) quotes; do not double-space them.

### Page Numbering and Front Matter

This is not an insignificant feature of your paper; failure to maintain correct pagination causes more papers to be completely redone than any other requirement. Please refer to the instructions for page numbering using Microsoft Word included at the end of these guidelines. Many hours of frustration may be eliminated with the use of these suggestions. **Students using LaTeX are strongly advised to prepare their front matter using Microsoft Word to avoid formatting issues.**

- DO NOT use running title headers; do not adorn the page number with any dashes or similar accessories—use only plain Arabic numbers (except Roman numerals used for the front matter—explained below).

- Make sure, especially if you are collating multiple files to produce the complete document, that all page numbers in your document, including Roman numerals, are the same exact font and point size.

The front matter pages appear in the following order:

**These pages (a-e) are unnumbered**
(a) Blank page (flyleaf)
(b) Title page
(c) Copyright page (optional – PhD and DMA students only)
(d) Signature page
(e) Abstract

**The pages (f-i) are numbered with lower case Roman numerals, beginning with ‘iii,’ whether that be the Table of Contents or one of the optional pages (f-h); the numerals are always centered at the bottom and continued to the first page of the text.**

(f) Dedication page (optional)
(g) Acknowledgment page (optional)
(h) Preface (optional)
(i) Table of Contents
Body of Document Pagination:

(j) First page of chapter 1 or introduction, numbered Arabic ‘1,’ at bottom center  
(k) The second page of each chapter to end of the chapter should have the page number in the upper right corner, roughly around the intersection of 0.5” from the top and 1” from the right (using the pagination methods below will ensure this position)  
(l) Repeat (j) and (k) for each section of the document including: chapters, the reference section, and each separate appendix, maintaining continuous pagination throughout the entire manuscript

Check that your page numbers neither verge too closely upon your text, nor appear too far away, e.g., in the very corner of the page, at the very bottom edge of the page, etc.; their position should be identical from one page to the next. Consistency, more than precision, is required in page number positioning.

- **Every page in your text,** to the last page of references or figures or appendices (whichever comes last in your case) **must be numbered consecutively.** The total page count, equal to the last numbered page of your text, is then noted in your abstract. If the Dissertation Editor(s) require that you make revisions to your documents, the final page count (post-revisions) must match the total number of pages noted on your abstract.

At the end of your paper place the following unnumbered pages:  
(m) Vita (optional)  
(n) Blank flyleaf

---

**Table of Contents and Division of Manuscript**

The Table of Contents typically includes, besides chapters and subheadings, an entry for the List of Tables and List of Figures (if applicable), references, any appendices, etc.

As a rule of thumb for your Table of Contents, consider everything that **precedes** it to be superfluous to the Table; in other words, **don’t** include listings for ‘Acknowledgments,’ ‘Dedication,’ ‘Abstract,’ or ‘Table of Contents’ in your Table of Contents. **Numbers listed should be right aligned and not crooked.**

- Remember that reference and appendix sections are not chapters and should not be titled ‘Chapters.’ However, each appendix should be listed SEPARATELY in the Table of Contents, and should follow the same page numbering rules as chapters within the document.

**Please note:** Any new section that begins at the bottom of a page must be accompanied by at least two complete lines of text. If it is not, be sure to move the new section to the top of the next page, or move the line of text back to the previous page. Along the same lines, avoid pages that contain one straggling line from a previous paragraph.
The author should make the required modifications to the manuscript so that it will resemble a single, unified, and complete work. Typically, in the case of the submission of several published or not-yet-published journal articles as the thesis, dissertation, or doctoral essay, this involves limitation to one abstract and one reference section.

### Tables, Figures, Graphics

**Be sure all information in tables and figures falls within the margin requirements.** This includes all data, grid lines, IRB stamps, etc. The font size for the text in tables and figures is flexible if the change is necessary to fit it into the margins. One trick for making graphics fit is to shrink the document using a copy machine and then use MS Word to print the page number on the reduced copy (ensuring that the image does not cross the margins.)

**Be sure that all the margins and page numbers are adjusted on landscape tables and figures.** Visualize how the document will look when it is bound. The landscape graphic will still need the page number and margins to be the same as other pages in the document. Please consult the template “Landscape Example” on the Theses and Dissertations Website.

Figure legends should be placed on the same page as the figure whenever space allows. Only if the figure is too large to allow its page to accommodate any added legend should the student produce the legend on the previous page.

### Abstract, Title Page and Vita

Please use the template examples provided on our Website. (MS Word is notorious for ‘helpfully’ capitalizing sentence fragments; if you use this word processor, examine your title and signature pages for inadvertent capitalization of words such as “the,” “of,” “partial,” “requirements,” etc. in the headings).

The abstract is subject to editing or truncation by the microfilmer if over 350 words. For this reason, some students prepare two abstracts: one of 350 words for PQIL, and the other to whatever length they choose. The body of the abstract is double-spaced and it is placed after the signature page. It is NOT counted or numbered.

**You will also need to attach one copy of your abstract to each certificate of defense.**

And last but not least,

- the date of graduation (which also appears on your title page in the following format):
  - If you are graduating in the Fall, the date is December 2007
  - Spring’s date is May 2008
  - Summer I’s date is June 2008
  - Summer II’s date is August 2008
  - Note that there is no comma in these dates
This is the date on which the degree is to be awarded—do not list the date of your defense. The date of your graduation, not the date of the oral defense of your document, is the date marked on your document. If you defend successfully in March 2008, you would put May 2008 down as your date of graduation, for example. Now suppose that you do not submit the paper to the Graduate School in time for May graduation. You must then fill out a new application for a Summer or December graduation, and you would then put the respective date on the abstract (as well as the title page and vita). Failure to observe this simple requirement may result in a delay of the posting of your degree.

The vita page is recommended but not required. This does not call for your c.v./resume. Consult the Vita template on our Website if you aren’t sure.

References and Notes

For information regarding what citation methods and styles are appropriate to your field, consult your advisor. Lacking any instruction from them, consult the list of style manuals below for suggestions.

Once you have selected a style, follow it carefully. All manuals clearly define the use, placement, punctuation and numbering of footnotes as well as the correct format for the reference section of your dissertation.

The Graduate School only requires that you single-space each reference entry and place a single blank line between each entry. Nevertheless, beyond the required single-spacing, the style that you choose must be followed with thoroughness, consistency and attention to detail. A sloppy reference section is a red flag for a problematic submission.

The Dissertation Coordinator prefers that punctuation such as commas and periods fall within quotes, while footnote numbers in the text are placed after commas and periods; that ordinary technical Latin phrases are not italicized; and, that all British spellings are automatically Americanized unless content dictates otherwise. Your text must maintain proper punctuation of common academic Latin abbreviations: et al.; e.g.; i.e.

Printing and Paper

Use 8.5 x 11-inch, white paper only. Double-sided copies are not acceptable. One copy of your manuscript must be on 25% cotton bond or better. The two additional copies required for PhD and DMA students may be printed on regular bond paper. If you use a copy machine you must also be sure that no toner smudges or other marks are introduced by that process. Be careful in making your extra copies that the paper reproduces clearly and neatly, especially in figures and charts. Inspect each copy to check for missing pages.
As a rule of thumb, if the paper has a watermark, it is acceptable for printing the archive copy. The archive as well as every other copy of your paper must be perfectly legible, without flaking or faint printing. Some paper can be too good for use in some types of printers.

The Dissertation Coordinator encourages all students who possess the wherewithal to incorporate color figures, compact disks, and similar sorts of bells and whistles into their document to do so. However, be aware that microfilming will not reproduce colors adequately. In fact, PQIL (ProQuest Information and Learning) advises that color plates be reproduced as black and white photographs for the archive submission (which is the copy from which the microfilm is to be made). The PQIL agreement (available at the Graduate School) contains extensive information regarding microfilming reproduction issues, as well as the acceptable digital formats for computer-operable portions of the dissertation. The Dissertation Coordinator can also attempt to answer questions not covered by the PQIL policy.

### Submission of Hard Copies and Electronic Documents

#### Submission of the completed document:

The **hard copies** of your thesis/dissertation/doctoral essay are to be submitted to the Dissertation Editor in the Graduate School (1541 Brescia Avenue).

- Copy #0 must be printed on 25% or better cotton bond paper
- Copies #1-2 (PhD and DMA students only) may be printed on standard bond paper
- Each copy must be placed in an unsealed manila envelope. Label the bottom spine of each envelope with the following information: your name, department, date of graduation, correct copy number, and an email address. See sample below.
- **If we are unable to contact you with correction requirements, your paper will remain unaccepted and your graduation will be indefinitely postponed.**

<table>
<thead>
<tr>
<th>C01234567</th>
<th>Psychology</th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="mailto:marv@email.com">marv@email.com</a></td>
<td>May 2007</td>
</tr>
<tr>
<td>Mary L. Doe-Jones</td>
<td>Copy 0</td>
</tr>
</tbody>
</table>

Envelope sizes will vary from 10x13 to 12x15 for lengthier documents.

Note bottom spine of manila envelope

This information should be visible when your document is stacked with other theses and dissertations.

**Electronic Copies of your final document (ETD)** must be uploaded to the Electronic Theses and Dissertations Database per the Dissertation Editor’s instructions and submitted on a CD with...
both PDF and original document versions (Word, TeX, LaTeX, WordPerfect, DocBook, etc.) in a CD case clearly labeled with all of the information mentioned above.

**PAPERWORK**

| Checklists, Certificates of Defense, Signature Pages, and Other Forms |

**PhD/DMA or Master’s Degree Checklists**

These are available for download in the ‘Paperwork’ section of our Website. Each submission packet should have the correct checklist for your degree as its cover page.

**Certificates of defense**

These are available for download in the ‘Paperwork’ section of our Website. Your chair and committee members should sign two certificates at the time of your successful defense (three copies if RSMAS). Attach a copy of your abstract to each original certificate, and submit these originals to the Dissertation Editor as part of the complete submission package, but don’t mistake these for similar forms your department may use. **The student is responsible for turning these documents into the Graduate School at the time of the final submission. Do not turn these or any other important documents unless they are part of your final submission. Your department should not submit these certificates on your behalf.**

- Be sure to print the committee members’ names below their signatures so that the certificates can be processed properly.
- It is also essential that the document title listed on this document be the accurate title, as your graduation record is generated from this certificate.

**Signature Page(s)**

A template is available on our Website. The Graduate School requires one original signature page printed on archive-quality paper. However, the Dean will sign up to three original signature pages for PhD and DMA students. Please follow the example closely, checking for correct capitalization of the heading and title, and **correct spelling of the Dean’s name (Dr. Terri A. Scandura) and the title of your paper. Your signature page MUST NOT have any spelling errors BEFORE it is signed.** If it does, you will have to retype the page and acquire new signatures for it. In doing so, you will delay the processing of your documents and your diploma.

**Surveys**

These are available for download in the ‘Paperwork’ section of our Website. Master’s students are required to fill out the UM Exit Survey; PhD and DMA students must also fill out the Survey of Earned Doctorates.
(PQIL) ProQuest Information and Learning Requirement (PhD & DMA Students ONLY)

This form is available for download in the ‘Paperwork’ section of our Website. The Graduate School requires that every doctoral student submit a completed (PQIL) Proquest Information and Learning Agreement. A pamphlet is available at the Graduate School for students who require more information regarding fair use copyright issues relevant to this obligation. Please remember that inclusion of copyrighted inventories and similar materials is a serious matter, and proof of the rightful use of such materials must be furnished with the dissertation. PQIL will remove any such materials that are not properly accounted for.

Notice that for a fee of $65 payable by money order only, PQIL will officially register your copyright, on your behalf, with the U.S. Copyright Office. You may perform this registration yourself, and then provide us with the proper documentation from that application. Otherwise, you may forgo formally copyrighting, in which case there must be no copyright page included in your document. Your rights as author are not infringed by refraining from formally copyrighting, nor does the Graduate School require or prefer that you formally copyright.

Don’t forget to sign the back of your PQIL agreement and attach a copy of your title page and abstract, whether or not you intend to copyright. Failure to sign the PQIL agreement and attach the above pages of your manuscript prevents processing of your dissertation for graduation.

Mailing Label (PhD and DMA Students ONLY)

Also available for download in the ‘Paperwork’ section of our Website.

Diplomas

The Graduate School does not issue your diploma. For information regarding the mailing or status of your diploma you must contact:

The Office of the Registrar
121 University Center
(305) 284-2294
http://www6.miami.edu/registrar/
Style Manuals

Biology

Chemistry

Education

Mathematics

Medicine

Physics

General
Turabian, Kate. *A Manual for Writers of Term Papers, Theses, And Dissertations.*

Campbell, Ballou, Slade. *Form and Style.*

For other style manuals and guides, see John Bruce Howell, *Style Manuals of the English Speaking World.* (Phoenix AZ: Oryx, 1983).
Microsoft Word Pagination

1. You will find it very helpful to separate your front matter (the title page, abstract, table of contents, etc.) from the main body of your document and keep it as two separate documents. Keep the unnumbered pages, such as the title page, signature page, and abstract as one document; keep numbered front matter, such as the dedication (if present), table of contents, etc., as another. In this way, the different page number formatting guidelines for these sections will not affect your main document. When submitting the paper, just print out the different components of the paper and put them together.

2. Do not put any sections breaks into your document before creating the page numbering scheme. (It is better to use Section Breaks as described below rather than Page Breaks.) First, go to the File menu and choose “Page Setup” under the “Layout” tab and check the box labeled “Different First Page.” Then, click “OK.”

3. Go to the Insert Menu and choose “Page Numbers.” For Position, choose “Top of page (header)” and Alignment “Right.” Do NOT check the “Show number on first page” box. When performing this procedure for your front matter, use the Format button to set the numbers to Roman numerals and indicate on which page the numbering should begin (as mentioned in the guidelines, the first Roman numeral should be “iii”).

4. You now have page numbers on the upper right hand side of your pages, beginning with page 2. To insert the page number on page 1, go to the View menu, and click on Headers and Footers. Go to the footer and tab the cursor over to the center and click on the insert page number button (#). Then click the Close button. The page numbers should now be in their proper positions.

5. In order to maintain the proper numbering scheme throughout the document, go to the end of the first chapter (or introductions) and click after the last character in the last line (probably a period) and insert a Section Break. To do this, under the Insert menu, choose “Break.” Choose a Next Page section break and click “OK.” Do not insert a Page Break; the Next Page break will serve this purpose.

6. Repeat step 5 as necessary for each subsequent chapter to achieve the correct page numbering format.

NOTE:
If you are having difficulty with the preparation of your document, you may consult Bryanna Herzog, Digital Production Service Manager at the Richter Library for access to a computer with software for ETD preparation or a personal consultation. Bryanna can be reached at (305) 284-2548. Keep in mind that fall and spring hours differ from those of the summer terms.
Preparing your Electronic Document

Your thesis must be submitted to the University of Miami ETD database as a PDF (Portable Document Format) document. PDF is commonly used to distribute documents online because it allows readers on different platforms (e.g. Windows, Mac and UNIX) to view files as originally intended by the author. The PDF is also an established format for long-term digital preservation and archiving.

Embedded Fonts Required

In order to ensure that the PDF version of your thesis or dissertation looks the same on all machines today and in the future, it is required that your PDF document is submitted containing copies of the fonts you have used. In technical terms, this is referred to as “embedding” your fonts. To do this your word processor-to-PDF converter software must be capable of embedding fonts. These examples of popular conversion software can be configured to embed fonts: LatTeX2PDF, Ghostscript, Adobe Acrobat Distiller, Adobe Acrobat Professional. Students creating manuscripts in TeX can create the PDF directly. In all cases, Type 1 outline versions of bitmap fonts must be used. Type 1 fonts are the norm for students using Microsoft Word. Though many of the recent LaTeX systems embed Type 1 fonts by default, be sure to double-check the PDF output produced by whatever implementation of LaTeX you use for full font embedding, and if necessary regenerate your PDF with the the fonts you used or their relevant subsets fully embedded.

Converting Microsoft Word to PDF using Adobe Acrobat Professional

The steps below describe the process of converting a manuscript prepared in Microsoft Word to PDF using Adobe Acrobat Professional.

Adobe Professional software is available for student use in The Graduate School and computers in the Richter Library Information Commons. The software can be purchased or downloaded for free for 30 days at www.adobe.com if you prefer to complete this step on your personal computer.

Step 1: Embed your fonts in your document processor.

Don’t leave home without your fonts! If you are taking your word processor files somewhere to convert them to PDF, you must embed your fonts in the word processor files before you leave the computer on which you have composed your document.

To do this in Microsoft Word:

1. Click on the “Tools” menu, then the “Option” menu item
2. When the Options dialog box opens, you can choose among many tabs; click on the “Save” tab.
3. Near the middle of the tab page, you should see “Embed True Type fonts” and “Embed characters in use only” under it. MAKE SURE both those options are checked. CLEAR (do NOT check) the “Do not embed common systems fonts” box.
4. Click “OK”

**Step 2: You must also adjust your Adobe Professional Settings before converting your Word file to a PDF.**

1. Open Adobe Professional (this software is available for student use from library computers and a small number of computers at The Graduate School)
2. Click on “Edit”, then “Preferences”
3. Select “Convert to PDF” from the left column of categories, then “Microsoft Office” in versions 6.0 and 7.0 of Adobe Professional, “Microsoft Office Word” in version 8.0.
4. Click “Edit Settings”, when the Dialog box opens, click “Edit Standards” in version 6.0 and 7.0; in version 8.0, click “Edit”.
5. Click “Fonts” from the list of folders on the left
6. Check “Embed all fonts” and “Subset embedded fonts…”; In the lower box on the right, remove any fonts that appear in the “Never Embed” box by highlighting the font and clicking “Remove” (You may select multiple fonts to remove by holding the “Shift” key and using the “↓” key to highlight)
7. Click “Save As” and save with file name “Embed all fonts”
8. Click “OK”
9. Click “OK” again.

**Note:** If your thesis or dissertation contains multimedia files of any sort, DO NOT embed them within the document PDF. To ensure they are saved in an acceptable format, check the “Accepted Multimedia File Types” list at the end of this section. If needed, please contact Kyle Rimkus at Richter Library (email: kyle@miami.edu) for additional assistance on how to process multimedia files.

**Step 3: (ONLY AFTER YOUR FONTS ARE EMBEDDED) You must convert your Word file into a PDF and name it correctly.**

1. a. If you have one unified Word file, Click “File” then “Create PDF” and “From File” and browse to the document.

   b. If you are converting multiple files into one PDF, Click “File” then “Create PDF” and “From Multiple Files”, then “Add Files” and “Browse”. Open the various files in the order they should appear in your final document.

2. Click “OK” and wait in versions 6.0 and 7.0 of Adobe Pro. In version 8.0, make sure that the “Default File Size” radio button at the bottom of the window is checked, and then click “Next”. If given the option, choose “Merge Files into a single PDF”, and click “Create”.

3. Name your PDF with the following format: Cane ID with no periods, plus semester of graduation, followed by the year of graduation (For example, John Smith with Cane ID j.smith5 graduating in December 2007 would be jsmith5F07)
NOTE TO USERS OF LaTeX: At present, we do not provide a fully styled LaTeX “thesis” document class for the preparation of electronic theses. While we may develop one in the future depending on a demonstration of need from the student body and academic departments which prefer to employ LaTeX rather than Microsoft Word, at present we recommend that students prepare the front matter of their theses using the Microsoft Word templates provided by that Graduate School, and the following LaTeX template for the body of their thesis. Students should then combine their Microsoft Word front matter with their LaTeX-generated document body using Adobe Acrobat Pro as outlined above.

Step 4: Make sure your fonts are embedded.

Check if all your fonts are embedded and subsetted by viewing the file with Adobe Acrobat Pro or the free software Adobe Acrobat Reader. If you do not have Acrobat Reader installed on your computer, the Library and The Graduate School have Acrobat Reader available for student use. You may also download install a free version of Acrobat Reader here: http://www.adobe.com/downloads/. Once installed, start the program and open your PDF file. Choose “File” then “Document Properties”, and click on the “Fonts” tab. From here you can confirm that each font used in your file is embedded and subsetted. After each font name, it should show “embedded & subsetted”. If it does not, then your PDF file is not compliant.

Step 5: Save your file to your own media.

Remember you will need to print a final copy from the final approved version of your PDF. Also, if your final uploaded version contains any errors the files will be removed by the Dissertation Editor(s), so it is very important to back up the most recent version of your document.

Multimedia Files

Students are recommended not to embed image, sound, video, or other multimedia files in their electronic dissertations, but to provide all supplementary multimedia files separately. A student whose dissertation refers to specific sound files, for example, should format the text of his or her dissertation according to the guidelines provided by the Graduate School, and submit supplementary content as discrete files.

In order to ensure long term public access to multimedia content, the Graduate School and the Libraries recommend that students submit multimedia files in one of our recommended formats. Should a recommended file format become obsolete, we guarantee full migration of submitted
files to the latest industry standards as these become apparent. Students who submit files in non-recommended formats will receive no guarantee as to the long-term accessibility of their files, as unsupported file formats will not be migrated.

RECOMMENDED FILE FORMATS:

Image Files
- PNG (Portable Network Graphics Format)
- TIFF (Tagged Image File Format)
- JPEG (Joint Photographic Experts Group)

Audio Files
- MP3 (MPEG Layer 3)
- WAV (Waveform)
- MIDI (Musical Instrument Digital Interface)

Video
- MPEG (Moving Pictures Expert Group)

OTHER FILE TYPES

Spreadsheets and Databases
- TXT (Plain Text)
- CSV (Comma-Separated Values)

Students are recommended to export spreadsheets and databases to a tab-delimited or comma-separated text file. When possible, students are encouraged to encode data sets in text files in the UTF-8 or UTF-16 Unicode character encoding.

Program Code

Students may upload uncompiled codes in the programming language(s) of their choice. Instructions for running submitted programs may be included in the Dissertation itself, in a separate README file, or both.